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1. Installation and Uninstall 
  



 

 

 

 

 

 

1.1 Software component 
 

The whole software contains a CD and an operation instruction.  

 

The CD contains all the installation procedure; this instruction introduces the operation of 

the software. 

 

1.2 Installation 
 

TGO software can be installed directly from the CD or the hard disk. It needs at least 32M 

internal storage and 200M hard disk. This software can be operated in the environment 

below: 

 

 Microsoft ® Windows 95, 97, 98,SE, ME
 

 Microsoft ® Windows NT Service Pack 4 and the latter version 

 Microsoft ® Windows 2000/XP 

 Microsoft ® Windows7 

 Microsoft .Net Frameworks 2.0
 

 

 Installation steps: 
 
If your computer has not installed Microsoft NET Framework 2.0 framework, please install 

the package "NetFrame2.exe first. 

 

Run the program “TERSUS Geomatics Office.msi” which in the installation directory. 



 

 

 

 

 

 
 
 

 

 
Figure 1-1 GTO wizard 

 

 

Click Next: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 1-2 TGO installation 1 



 

 

 

 

 

 

Choose an installation path and then click Next： 
 
 

 
 
 
 
Click Install: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1-3 TGO installation 2 

Figure 1-4 TGO installation 3 



 

 

 

 

 

 

Wait until the entire program is installed successfully, then you will see the interface below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

There will be a Tersus Geomatics Office directory generated automatically in the Start 

menu, and this file contains several icons (look at the picture below). 

 
 
 
 
 
 
 
 
 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

Figure 1-5 TGO installation 4 

Figure 1-6 Start menu 



 

 

 

 

 

 

1.3 Uninstall 
 

Select Start\Program\Tersus-Geomatics Office\Uninstall to uninstall TGO. 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Figure 1-7 Uninstall 



 

 

 

 

 

 
 
 

2. Quick Start Guide 



 

 

 

 

 

 

In this chapter, we will provide the draft procedure about TGO software to resolve the data 

of static or dynamic. This chapter helps you to complete data processing roughly. 
 

2.1 Static GPS Data Processing 
 

2.1.1 Create a new project 

Run TGO software, click button in the navigation field to create a new project (Figure 

2- 1). If necessary, set the project name and folder to store the project files. Otherwise, the 

files will be stored in the installation folder (Figure 2- 2). Click OK button to finish the 

project creation. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Figure 2- 1 Project menu 



 

 

 

 

 

 

 

 

The project name and the directory to save the project files can be changed. 

 

 

2.1.2 Set Property of the Project 
 

Follow the wizard or click button in the navigation field, the Project Properties dialog 

appears as Figure 2- 3. You can set the detail info of the project. Generally, you need to set 

the tolerance tab. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Figure 2- 2 New project 

Figure 2- 3 Tolerance bar 



 

 

 

 

 

 

 

2.1.3 Set up a Coordinate System 
 

It is necessary to set up the coordinate system parameters for a new project. Click 

button in the navigation field, the following dialog appears as Figure 2- 4. Generally, it‟s 

only needed to set the fields in Ellipsoid, Projection and Convert tabs. You can find more 

details of coordinate parameter setting in the following sections. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

2.1.4 Import Static Data 
 

Once you have set up your TGO project, you can import data into it. 

 

Figure 2- 4 Coordinate system 



 

 

 

 

 

 

 

Select  Import Files item in the navigation field, we can load on GPS data observation 

files (Figure 2- 5). Select static or auto mode in the dialog, click Select Files button or 

double-click to enter the file selection page, as Figure 2- 6: 

 
 
 
 
 

Import data files 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
 
 
 

 

Figure 2- 5 Import menu 

Figure 2- 6 Import files 



 

 

 

 

 

 

Select the static files, as Figure 2- 7, you can press CTRL or SHIFT key to select multi- 

files, click Open to import the files (Figure 2- 8): 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
  
 
 
  
 
 
 
 
 
 
 
 
 

 

 

 

After importing the files, TGO software can automatically generate the baselines, repeat 

baseline, sync loop, asynchronous loop and so on (Figure 2- 9). 

 
 
 
 

 

 

Figure 2- 7 Select mutiple files 

Figure 2- 8 Imorting files 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

2.1.5 Edit Files Information 
 

After all the files are loaded, TGO will display all the observation files. Select the 

Observation files and switch to Obs-files tab in the working field, and then you can see all 

files (Figure 2- 10). Double click one file to enter the editor window. Make sure the height 

antenna, the type of receiver and antenna are right (Figure 2- 11). Check these items for all 

files. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Figure 2- 9 Import files successfully 

Figure 2- 10 Observations files 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

2.1.6 Baseline Processing 
 

After all the data are loaded, TGO shows all the GPS baseline vectors and the plane view 

shows all the information about the GPS network. 
 

Then you can process the baseline, click Process Baseline -> button on the 

navigation field to process baselines, TGO will process all the baselines according to 

the default settings (Figure 2- 12) 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

Figure 2- 11 Edit an observation file 

Figure 2- 12 Baseline processing 



 

 

 

 

 

 

 

During the processing, program shows the schedule of the baselines as Figure 2- 13, we can 

find the processing information about each baseline processing in the list of Baselines. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

The time of baseline solution depends on the number of the baseline, the time of the 

observation, the baseline processing setting and the performance of the computer. After all 

baselines are completed, the baseline solution result displays in the baseline list window.  

 

The color of the previous unsolved baseline in the map changes from light to dark green. 

(Figure 2- 14) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Figure 2- 13 Baselines’ schedule 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

2.1.7 Adjustment Setting 
 

After the baseline processing, it is needed to check the adjustment result. But for this simple 

section, we suppose all the baselines are good. Generally, if the observation condition is 

good, we can process all the baselines once successfully. 
 
It is needed to delete part of a baseline, according to the quality of synchronous observation 

after the solution. Here we will not explain it, too. 
 
Now we begin to prepare the network adjustment. 
 
First we should set some points as control points. Switch work field to Points tab, select one 

site and right-click the selected site. Then select Set as Control Point, the selected point 

will be add to the list of control points automatically (Figure 2- 15). 

 
 

Figure 2- 14 Processing result 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Switch work field to Points tab, you will find this point which you set as control point 

(Figure 2- 16). Double click one point‟s name, you can edit these points as Figure 2- 17. Do 

this for all control points. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2- 15 Set control point 

Figure 2- 16 Control points 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2.1.8 Network Adjustment 
 

Click  button in the navigation field in the navigation field, enter the adjustment 

setting window (Figure 2- 18). After setting adjustment options, you can choose 

Adjust item, then Network Adjustment tool window appears in Figure 2- 19. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2- 17 Control point details 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Click Auto Adjust button, it will do free 3D adjustment, constraint 3D adjustment under 

WGS84 ellipsoid, constraint 3D adjustment and 2D adjustment under local ellipsoid 

according to the settings above. It also can generate adjustment result list. 

 

 

Figure 2- 18 Adjust options  

Figure 2- 19 Network adjust 



 

 

 

 

 

 

 
 

2.1.9 Report 
 

Click button in the navigation field, you can set output items which you want to view 

in the adjustment report and the format of adjustment report (Figure 2- 20). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Then click  to select one result which you want to view in the adjustment result lists, 

click Get Report button. It will generate adjustment report as Figure 2- 21.You can find the 

content of the report in the following chapter. 

 
 
 
 

Figure 2- 20 Report options 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

At this time, the processing is completed. You can select in the navigation field to 

export the solution result. 

 

Next we will introduce how to process dynamic GPS data. 
 
 

2.2 Dynamic Route Processing 
 

Dynamic GPS data processing has three solving mode: RTD, Stop&Go, PPK (Post Process 

Kinematic). The difference of them can be found in chapter 4.55.1. 

 
 

2.2.1 Import Data 
First we create a project as static GPS data processing. Because during the outdoor 

observation, one dynamic baseline includes two files at least, one is a static observation file 

and the other is a dynamic observation file, they are collected synchronously. When you 

import the observation data files with dynamic and static mode, make sure which file is 

static and which is dynamic. Generally, data files exported from rover is dynamic files, 

from base or CORS is static file. If you import data files by auto mode, you just need to 

import all observation data files (Figure 2- 23). 

 

 

 

 

 

Figure 2- 21 Report demo 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2.2.2 Set Property of Observation Files and Points 
 

Set the Mode of Observation Files 

 

If you import data files by auto mode, you need to convert the data file which is exported by 

rover to dynamic mode. Click Switch to Static/Kinematic menu in the pop-up menu as 

Figure 2- 24. 
 
 
 
 
 
 
 
 

 

 

Figure 2- 22 Import files 

Figure 2- 23 Static and dynamic file 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Edit the Coordinate of Points 

 

Select the Points node in the left of work field, choose the base point (reference station) and 

double click it, Station window displays as Figure 2- 25. Edit and confirm the coordinate of 

the station. 

 
 

 
Notice: The coordinate of reference station must be accurate, or 

the error will be introduced to the solution. 
 
 
 
 
 
 
 
 
 
 
 

Figure 2- 24 Observations files mode 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Add Stop&Go RSP File 

 

Stop&Go RSP file is a time file which record the start time and end time of a stop stage in 

field work. If you do stop&go or PPK processing, you can add stop&go RSP file to 

dynamic observation file. If you don‟t add stop&go RSP file, TGO will do processing, too. 

In fact, the result is just pure dynamic solution and you only get go stage solution in the 

report. Select Stop&Go RSP File menu item in the pop-up menu as Figure 2- 26, add 

corresponding stop&go RSP file. 

 
 

 

Notice: Because observation file is divided into stop stage files by 

RSP file, the correctness of RSP file is very important. Make 
sure that the observation time of RSP file is consistent with 
observation files. 

 
 
 
 
 

Figure 2- 25 Reference station position 

http://dict.youdao.com/search?q=corresponding&keyfrom=E2Ctranslation


 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2.2.3 Dynamic GPS Data Solution 
 

After the operation of the above, the next step is to process baselines. 
 
Processing Settings 

 

Select the Baselines node in the tree list view, you can see the detail view switch to 

Baselines tab page. Right click one or more baselines. Select Process Options menu item in 

the pop-up menu (Figure 2- 27), enter the following window as Figure 2- 28. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Figure 2- 26 Add RSP file 

Figure 2- 27 Process options 



 

 

 

 

 

 
Notice: If you do Stop&Go processing, it‟s suggested that you set  

the minimum epoch to 180s. If the minimum epoch is too small,  
the integer ambiguity will not be fixed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

Select Dynamic tab page in the above window, set the mode of procession as Figure 2- 29. 

After you finish your settings, click Apply to button to complete setting and back to work 

window. 
 
 

Figure 2- 28 Minimum time for stop&go 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Process Baseline 

 

Select Process Line menu item in the pop-up menu, begin to process the chosen baselines. 

You can see solution status on the process status bar as Figure 2- 30. 

 
 
 
 

 

Solution Type 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 2- 29 Dynamic options 

Figure 2- 30 Porcessing status 



 

 

 

 

 

 

After processing, you can view the plan map of dynamic route. The green color means fixed 

solution, yellow is float, red is single. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Click button, the map display as Figure 2- 32.The map just display the stop points. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Report 

 

Select Process Line menu item in the pop-up menu to generate the solution result report. 
 
 
 
 

Figure 2- 31 Project plot 

Figure 2- 32 Stop points 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

A static baseline control network has been processed now. You can select  to export 

the solution result. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2- 33 Report demo 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Main Window 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 

 

 

 

 

 

3.1 TGO Main Window 

Run Tersus Geometrics office Software Package in the Start menu, or directly press  

Icon, it enters the main window. Now you can get the window as Figure 3-1. This window 

includes Menu bar, Tool bar, Status bar, Navigation field, Message field, Work file, etc. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Select file menu or select a project in the Project Navigation Filed, open a project, if you 

select GPS (China) Pro which is a demonstration project, you will find the window in 

Figure 3- 2. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3- 1 Main window 
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According to the design, user window includes fields as following: 
 
 
Title bar: Title bar can help you quickly determine the type of current application. And you 
can do a few programs controlling, such as, Maximum, Minimum and Exit program. If you 

open a project, it will display the project name. 
 
Menu bar: The list menu is an important part of any type window. It supplies many 

commands to create engineering files, process data, and manage data. 
 
Tool bar: Provide majority common shortcut keys to fast operation. 
 
Status bar: Display a few guides about current operations. 
 
Work field: It is the user‟s main work field, generally includes every type views related to 

the project. 
 
Navigation field: Provide common shortcut keys for fast operation. 

 

Message field: Output message of processing. 
 
We shall explain all the operations to the main program in the following sections.

Figure 3- 2 Fields in main window 



 

 

 

 

 

 

3.1 Menu and Toolbars 
 

Menu 

 

The main menu of the program includes File, Baseline, Adjust, Tools, Options and Help. 

Every menu item has a window shortcut key. The menus provide the operation to complete 

most of the data processing work and the main processing steps. 

 

 

 

 

Tool Bar 

 

You can achieve a few common operations and accelerate the rate via the Toolbars in the 

main program. It includes create new project, open project, save project, import data, export 

data, get default view (Figure 3- 4). 

 
 

 

 

 

3.2 Navigation Field 
 

The navigation field is a quick entrance of menus; you can show or hide it. It is used to 

make user‟s operation faster. 
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Figure 3- 3 Main menus 

Figure 3- 4 Tool bar 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

3.3 Plan View 
 

Plan view in the work field mainly displays the added information, such as site, baseline, 

error ellipsoid, scale, grid and so on. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Figure 3- 5 Import sub-menu 

Figure 3- 6 Plan view 



 

 

 

 

 

 

Observation Site 

 

In the map, ▲ means that GPS observation site have been associated with the control site. ● 

means that GPS observation site is a common site. 
 
Baseline 

 

The static baseline is marked by arrowhead line, and the arrowhead can be hidden. When it 

can‟t be resolved, or hasn‟t been resolved, the baseline is gray. 
 
Move the mouse, when you click the site or baseline, the site or the baseline will be 

high-lighted as Figure 3- 7. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Error Ellipsoid 

 

After finishing baseline processing the error ellipsoid and the height residual of baselines 

will be displayed with green color. It shows the baseline resolving quality. 

 
 
 
 
 

Figure 3- 7 Sites and baselines 



 

 

 

 

 

 

Graphical Operation Tools 

 

Graphical operation tools are on the upper right corner of the plan view. Click the tool 

firstly, then click the network graph, you will achieve the corresponding graphical 

operation. 

 
 

 

 

 

 

 Select Button: Select the site and baseline of the network graph. 
 

Square Select Zoom Button 
 

Zoom Out Button 
 

Zoom In Button 
 

Full Screen Button 
 

Pan Move Button 
 

Grid Reference Line Displayed Button 
 

Error Ellipse Displayed Button 
 

Rover Point Displayed Button 
 

 

Setting the Drawing Mode of Plan Grid Reference Line 

 

Choosing Options->Customize menu item to enter custom configuration dialog (Figure 3- 

9), you can choose the language and the drawing mode of plan grid reference line as plan or 

geodetic coordinate. 

 
 
 
 
 
 

 

 

Figure 3- 8 Operation tools 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

3.4 Tree List View of Work Field 
 

The left of the work field is a tree list view. It‟s used to manage all contents of the project, 

including points list, baselines list, synchronous loop list, asynchronous loop list, 

observation files list and ephemeris files list. Click one node in the list, the detailed view 

will display some related information according to the selected node. For example, click 

Points node, the detail view will display Project Plot, Points and Control Points and 

position on Points tab (Figure 3- 10). 

 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 3- 9 Customized options 



 

 

 

 

 

 
 
 
 
 

Tree List View 
 

 

Detail View 
 
 
 

 

 

 

3.5 Detail view of Work Field 
 

The detail view of work field contains several tabs, every tab will display or hide to get 

different display combinations according to the selected node of tree list. 

 
 

 

Notice: The tabs of detail view will change automatically according to 
the selected node of tree list, users don‟t need to search. 

 
 

 

Pop-up Menu of Detail View 

 

Select one item in the detail view, and right click it, the pop-up menu will display as Figure 

3- 11. 

 
 
 
 

Notice: Pop-up menu will change when the tab content changes. 
 
 
 
 
 
 
 
 
 
 

Figure 3- 10 Tree list view 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Property Window 

 

Choose Edit in the pop-up menu, you can edit properties of the chosen item. Property 

Window is different as different tab of detail view. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 

 

 

Figure 3- 11 Pop-up menu 

Figure 3- 12 Edit properties 



 

 

 

 

 

 

 

 
 
 
 

 

4. Project Management 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 

 

 

 

Tersus Geomatics Office Software Package is managed via the Object Oriented method, so 

whether you do point positioning, do static baseline processing, dynamic route processing, 

or even do network adjustment, you should create a new project or open an existed project 

firstly. 
 
Follow the steps below to create a new project: 
 
1. Create a new project firstly, enter the project name and the save path; 
 
2. Enter property and tolerance of the project; 

 

3. Enter the coordinate parameters in the coordinate management system. 
 
After this, you can do the next operations. 

 
 

4.1 Create a New Project 
 

Set the Property of a Project 

 

Click Project / Project property or click  in the navigation field to set the property of 

the project. 

 
 
Base Information 

 

The basic Information all display in the report of the network adjustment. 
 
 
 
 
 
 
 
 
 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Tolerance 

 

The tolerance of project is very important. You can choose national standard or custom 

define standard. Many tests are conducted according to the tolerance settings during data 

processing. The details precision dilution can be found in the Global Position System (GPS) 

Survey Criterion. 

 
 
 
 
 

Figure 4- 1 Project properties 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Advance 

 

Advance setting determines the control item of data processing, such as using first four 

characters of *TRS file as the point name of observation file, Minimum Time span of Static 

Baseline and Dynamic Baseline. 

 
 
 
 
 
 
 
 
 
 
 

 

 

Figure 4- 2 Tolerance tab 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Set the Coordinate Parameters 

Click File menu->Coordinate System item or click  in the Project navigation field to 

set the coordinate parameters. Generally, you can set coordinate parameters by following 

common three steps. 
 
Set Ellipsoid 

 

Ellipsoid tab page can set the Source Ellipsoid and Target Ellipsoid. You just need to select 

the ellipsoid name in the Ellipsoid combo box. If the ellipsoid can‟t be found in TGO,

Figure 4- 3 Advance tab 



 

 

 

 

 

 

 

please contact our support to get parameters of the ellipsoid. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Set Projection 

 

Projection tab page includes projection method and parameters of projection. Select the 

projection method and enter the corresponding parameters. If the projection method is not 

available, please contact our technicians and provide the calculation method and 

corresponding parameters. 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

Figure 4- 4 Ellipsoid tab 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Set Conversion 

 

Convert tab page is used to set parameters of datum conversion. Select one model in the 

Model combo box and enter the corresponding parameters. If you have no model 

parameters, you can use our Coord Tool to calculate. If the model is not available, please 

contact our technicians and provide the calculation method and corresponding parameters. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4- 5 Projection tab 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The files will be created during a project processing. These files are saved in the project 

route and subdirectory. When we view the project subdirectory (Figure 4-7), we can find a 

project file “*.TGO” and six subdirectories created in the project directory. Adjust 

subdirectory is used for save the information during adjustment processing, Baseline 

subdirectory is used for keep the baseline processing information, EphBinData 

subdirectory is used for save the Ephemeris data, ObsBinDat subdirectory is used for save 

the observation data, Report subdirectory is used for save the report document, Rinex 

subdirectory is used for save the rinex files transformed from the observation files. 

 
 
 
 
 
 

 

Figure 4- 6 Convert tab 



 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 

 

 

So all the data and the processing information are saved in the same subdirectory, when 

completed this project, you can pack and save the whole directory and the corresponding 

subdirectory. In addition, the project folder can be transplanted from one computer to 

another computer and be opened. 

 

 

4.2 Observation File 
 

The data formats exported by the GPS receiver are NEMA0183 and the original survey 

data. In the term of TGO (Tersus Geomatics Office) Software Package, it needs the 

original survey format. The original surveying data of most GPS receivers is binary format, 

which is different from each other. 
 
TGO Software Package can process data with the defined format, the data from several 

popular GPS receiver. It supports RINEX text format, too. 

 
 
The Content of the Observation File 

 

The observation files mainly save the original observation data of each ephemeris recorded 

by the GPS receiver. Each ephemeris includes observation time and the satellite 

information of every channel, C/A code, P1 code pseudo-range, P2 code pseudo-range, L1 

carrier phase, L2 carrier phase. For the static observation files of the TGO Software 

Package, it is necessary to include the observation time, C/A code pseudo-range, L1 carrier 

phase; For dynamic observation files it is necessary to include the observation time and the 

C/A code pseudo-range. 
 
The observation files include information besides the above of the point information, initial 

coordinate and the ephemeris information correlative the observations files. 
 
In order to process stop&go data, stop& go time files is necessary except for static data file. 

It includes the start observation time and end observation time of a point. 
 
The observation files can be expressed as the follow Figure 4-8: 

 

 

 

 

 

Figure 4- 7 Project subdirectory 



 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 4- 8 Observation files format 



 

 

 

 

 

 

 

The TRS/GNS Format Observations of Tersus Receiver 

 

The observation files of the TRS or GNS Format defined by Tersus include the original 

observations, ephemeris data, the coordinate of the start and end points, several editions 

including the point information and the rout information of the dynamic capture record. 
 
The Observation in the RINEX Format 

 

In order to process the data unified collected by different types of receivers, the RINEX 

format, which is a universal data format, is established. The RINEX format is brought 

forward by the Berne University, Astro Institution in Switzerland. It has become a standard 

format among all the manufacturers, schools and institutes now. And currently the main 

GPS receivers are all supporting to transform the observations to RINEX format. 
 
Other Observation Format 

 

TGO also support other observation format, such as SP3 format. 
 
Data Preparation 

 

The TGO Package has the ability to process a few types of data format. 
 
Generally, you should do the next steps before processing a group of GPS observations: 

 
 
 
 



 

 

 

 

 

 

Import Data 

 

Click File menu->Import or click in the navigation field. 

 

 

 

At the right of the dialog, there is an Observation file mode combo box, it includes three 

modes: Auto, Static and Dynamic. 
 
Auto: Import both static and dynamic data file. The mode of all imported files is static. 
 
Static: Import static data file. 
 
Dynamic: Import dynamic data files which is exported by rover. 
 
Import folder, the TGO Package can import all files which meet the conditions 

automatically. 
 
If you select import GNS data files, the program will pop-up a file dialog as Figure 

4-10.File dialog will be transferred to the path of current project and lists all files with 

corresponding extension. You can select one or multiple files. 

 
 
 
 
 

 

Figure 4- 9 Import files 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

File import only imports observation files. In fact, at the same time, it imports the 

corresponding ephemeris files. For the files in the TRS/GNS format, the observations file 

and the ephemeris are included in one file, so they are imported at the same time. For other 

format, the observation file and the ephemeris may be not in the same file, then they should 

be saved in one directory, and the software will automatically distinguish and import the 

ephemeris by the format of the file. Or, the user should input the ephemeris in the post 

processing. 

 
 

 

After all the files are imported, TGO will get the observation station from the observation 

files and automatically assemble to the static baseline and the dynamic route by the 

observation time spans, you will find more detail in the following (Figure 4-11). 

 

Figure 4- 10 GNS files 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 4- 11 All the observations files 



 

 

 

 

 

 

 
 
Pop-up menu of the Observation File 

 

Select a file in the Obs-Files tab in the detail view, right click it, then the pop-up menu will 

display as Figure 4- 12, then you can operate the observation file. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Property of Observation File 

 

Select a file in the Obs-Files tab in the detail view, right click or double click it, and select 

Edit in the pop-up menu. You can edit the property of the selected observation file in Figure 

4- 13. 

 
 
 
 

 

Figure 4- 12 Pop-up menu 



 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Single Point Positioning Result of Observation File 

 

Choose a file in the Obs-Files tab in the detail view, right click it, and select Single 

Positioning Result in the pop-up menu. Then Single Point Position tab will be activated, 

the single point positioning result of the observation file will display in the plan view, as 

Figure 4- 14. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4- 13 Edit observation property 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

The Data Track Map of Observation 

 

Choose a file in the Obs-Files tab of the detail view, right click it, and select Data Track in 

the pop-up menu. Then Data tab will be activated, the tracking information about each 

satellite of the selected observation file displays in the plan view as Figure 4- 15. The 

interruption part means blockage of the satellites of the receiver. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Figure 4- 14 Single position menu 

Figure 4- 15 Data track status 



 

 

 

 

 

 

The Tracking Satellite Map of Observation 

 

Select a file in the Obs-Files tab of the detail view, right click it, and select Skyplot in the 

pop-up menu. Then Sky Plot tab will be activated, the sky plot and SNR (Signal to Noise 

Ratio) plot about all the tracking satellites of the selected observation file displays in the 

plan view as Figure 4- 16. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Transform Observation Data to the RINEX Format 

 

Choose a file in the Obs-Files tab of the detail view, right click it, and select Convert to 

Rinex in the pop-up menu. Then the selected observation file will be converted to a RINEX 

format (Figure 4- 17). The options of RINEX file can be selected by choosing Rinex 

Options item menu in the pop-up menu to set up (Figure 4- 18). The created Rinex file is 

saved in the RINEX subdirectory of the corresponding project directory. You can view 

them by clicking Open Rinex Folder menu. 

 

Figure 4- 16 Skyplot infomation 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 
 
 
 

Figure 4- 17 Convert to Rinex format 

Figure 4- 18 Rinex options 



 

 

 

 

 

 

Stop &Go RSP File 

 

If you do stop&go data processing, you need to add stop&go RSP File (stop&go time file) 

to dynamic file. Choose a file in the Obs-Files tab of the detail view, right click it, and select 

Add Stop&Go File in the pop-up menu (Figure 4- 19) to add a RSP file to this observation 

file. Click View Stop&Go RSP File to view the RSP file you have added. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

You can delete stop&go RSP File too, just select Delete Stop&Go Info menu item in the 

pop-up menu. 

 
 

4.3 Observation Station 
 

Click the Points node in the tree list view, and the right detail view will display information 

about site. There are two tabs in the right detail view, including points tab, control points. 

The control point list information is used to adjust network, and has nothing to do with 

baseline procession. 

 
 
 
 
 

 

 

Figure 4- 19 View stop&go info 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

The detail view lists each observation site name, fixed (whether the control points 

associated with it), spatial rectangular coordinate under WGS84 coordinate system and grid 

coordinate in local system. 
 
Pop-up Menu of Observation Station 

 

Right click the selected site, pop-up menu display as Figure 4- 21. You can change the 

properties of the point. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 4- 20 Points 

Figure 4- 21 Pop-up menu for points 



 

 

 

 

 

 

Property of Observation Site 

 

Select Edit in the pop-up menu or double click selected site, you can set the property of the 

observation site, such as its name, WGS coordinate, local grid coordinate. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

TGO software package record all coordinate source, such as an observation file. You can 

change the coordinate source of a site by selecting source in the source pull down menu and 

apply it by clicking Apply button. Click Edit button to enter coordinate. 

 
 

4.4 Baseline 
 

Click the Baselines node in the tree list view, and the right detail view will display 

information about baselines (Figure 4- 23). 

 
 
 
 
 

 

 

Figure 4- 22 Edit site 



 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Pop-up Menu of Baseline 

 

Click the Baselines node in the tree list view, and the right detail view will display 

information about baselines (Figure 4- 24). 
 
With this pop-up menu, you can set procession option, process baseline, view report and 

delete baseline. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

Figure 4- 23 Baseline menu 

Figure 4- 24 Pop-up menu for baseline 



 

 

 

 

 

 

 

 

4.5 Repeat Baseline 
 

Click the Repeat Baseline node in the tree list view, and the right detail view will display 

information about repeat baseline (Figure 4- 25). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4- 25 Repeat baseline info 



 

 

 

 

 

 

 

 

 
 
 
 

5. Baseline Processing 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

 

 

 

 

 

5.1 Processing Options 
 

Before processing baseline, processing options must be set. Right click one baseline, select 

Process Option item in the pop-up menu, or click  in the navigation filed, the 

following dialog display: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

The dialog is consisting of four setting pages: General, Ion/trop, Dynamic and Advanced. 
 
 

General Setting 

 

For static baselines, the minimum epoch count is 5s, or observation data can't form the 

baseline; for dynamic baseline, the minimum epoch count is 180, or the integer ambiguity 

can‟t be fixed.

Figure 5- 1 Baseline processing options 



 

 

 

 

 

 

Cutoff Angle 

 

Cutoff angle is used to limit the satellite data with relatively lower height angle, these data 

won‟t be processed when you processed baseline. 
 
The signals from low cutoff satellites are not easy to use. Besides, the signals of lower 

height can be influenced by several factors, such as multi-path effect, electromagnetic 

waves or an in deliberate jammer. So generally the quality of these signals is not good. 

These signals should be removed from the procession. 

 

From the atmosphere refraction perspective, observation for a short distance can be reduced 

cutoff angle height; for long distance observation, cutoff angle should be increased. The 

shorter the distance, atmospheric refraction affects is easier to be removed. Cutoff angle 

should be determined according to the field condition. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

The default cutoff angle is 20 in TGO software package. 
 

Figure 5- 2 Cutoff angle 



 

 

 

 

 

 

Sampling Interval 

 

The epoch interval is the data interval taken from the original observational data drawn 

Take in the baseline process. 
 
For example: when two receivers are processing static surveying, they are set up to capture a 

group of data every 5 seconds. But when it comes to the inside processing, this high density 

data usually degrades the accuracy of the baseline processing, instead of increase. So in 

order to accelerate the processing rate, user can increase the interval time appropriately. 

Generally, for the short line, and the observation time is not long, you can reduce the interval 

time appropriately, while for the long line, you can increase the interval time. e.g. For a 

static baseline shorter than 2 k, and the observation time within 20 minutes, then you can set 

up the interval to be 5seconds. But if the baseline is longer, you can increase the interval to 

60 or 120 seconds. 
 
Why set up so little interval surveying in outdoors? Because the random of the 

Observations and the limit of the software, you can change the epoch interval then process 

the baseline again to get a better result when you have the worse data. The default epoch 

interval is 60 seconds. 
 
Minimum number of epoch 

 

Because the dual-difference is formed via the difference of the single-difference 

observations among the satellites, for simple processing purpose, the software fixes a 

reference satellite when form the dual-difference observation value. The default minimum 

number of epoch is 5.



 

 

 

 

 

 

Observations (Frequency) 

 

You can choose different combinations of observed values to process baseline, such as wide 

lane Lw, narrow lane Ln and so on. When auto mode is chosen, TGO can automatically 

select the type of observations according to the baseline length. Generally, baseline less than 

5km use L1 observations, baseline greater than 5km use a Lc ionosphere-free combination 

observations. 
 
Ephemeris (Navigation) 

 

You can choose the broadcast ephemeris or precise ephemeris to process. Generally, if 

baselines are very long, precise ephemeris can improve the accuracy of the baseline 

solution; for short-distance baselines, the broadcast ephemeris can meet the requirements. 
 
Reference Satellite 

 

The default of reference satellite is auto. In this mode, TGO will select the observation data 

from the satellites with the greatest elevation angle as a reference satellite. 
 
However, due to the influence of the conditions of observation, such choice may not be the 

most reasonable .When the reference satellite selected is not reasonable, the results of the 

baseline processing will be affected. Under this condition, you need to set the reference 

satellite based on observation data. 
 
Auto-Process Mode 

 

TGO software package can remove the gross errors in satellite data automatically. It can 

help users to reduce the work of removing the data manually and get the qualified baseline 

solution in short time. This feature can be enabled if "enhanced" is chosen. If the user 

wants to remove the data manually, just choose "general". 

 

 



 

 

 

 

 

 

Dynamic Solving Mode 

 

This page is used to set dynamic route procession mode. This tab is only used for dynamic 

route processing. Dynamic GPS data processing has three solving mode: RTD, Stop&Go, 

PPK (Post Process Kinematic). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

Auto: Software will choose mode to process baseline according to the existence of 

stop&go RSP file. No RSP file, using RTD mode, or Stop&Go mode. 
 
RTD: The solving method of integer ambiguity for RTD solution mode is pure dynamic 

method. It can achieve 5 m precision within 300 kilometers and above 1m precision within 

100 kilometers. 
 
 
 

 

 

Figure 5- 3 Dynamic mode 



 

 

 

 

 

 

Stop&Go: This solution mode is suitable for short, middle, long baseline processing. Both 

stop stage and go stage is processed according to the principle of least squares method. The 

solving method of integer ambiguity, for stop stage, is fast static method and for go stage, is 

pure dynamic method. The precision of solution mode has better repetition than PPK, 

because it only has one ratio value. 
 
PPK: This solution mode is suitable for short, middle baseline processing. Both stop stage 

and go stage are processed according to Kalman Filtering method. The solving method of 

integer ambiguity, for go stage, is pure dynamic method. For stop stage, integer ambiguity 

is obtained according to the dynamic single epoch results. The precision of this solution 

mode has less repetition, because every epoch has a ratio value. 

 
 

 
Notice: If the quality of satellites single is good, the result of PPK and 

Stop&Go is much same. But if the quality of satellites single is 

worse, you‟d better choose PPK solution method. 
 
 

 

Ionosphere/ Troposphere 

 

In general, not need to change the troposphere, ionosphere settings. Long baseline can 

improve the solution setting precision according to actual situation. 

 
 
 

 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

Advanced 

 

In general, the default value can meet the requirements. It‟s recommended that users keep 

all the default parameters in this tab, any change may influence the solution stability. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5- 4 Ion/trop options 

Figure 5- 5 Advanced options 



 

 

 

 

 

 

 

 

5.2 Baseline Processing 
 

After all the settings are finished, select Baseline/Process line all baselines, or click  

in the navigation field, the software will process each baseline in sequence and display the 

information frame. 
 
During the processing, click Cancel button, then you can stop process baseline. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

The baseline solution result will display in the message filed after the solution as Figure 5- 

7. 

 
 
 
 
 
 
 
 
 
 
 

Figure 5- 6 Baseline processing 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

If there is warning, click one warning message and you will find the corresponding baseline 

in the list. The result of the solution can form the baseline report via select 

Baseline->Report or click on  to create a baseline report. 

 
 

5.3 Test Baseline Processing Result 
 

Control Baseline Quality 

 

After the baseline is processed, you can check the quality of the baseline by the quality 

standards such as RATIO, RMS and the point precision. 

Figure 5- 7 Baseline information 



 

 

 

 

 

 

 

 

 

5.3.1 RATIO 
 

The RATIO is the ratio of the less least RMS and the Least RMS after the integer 

ambiguity analysis, that is: 

 
 
 
 

 

The RATIO reflects the reliability of the integer ambiguity parameter, which is determined 

by a few factors. It is related to the observation quality and the observation time. 

 

The RATIO is a key factor to the quality of the baseline, generally, the RATIO is required to 

be bigger than 1.8. 

 

RMS 

 

RMS is the Root Mean Square, that is: 

 
 
 
 
 
V is the residual of the observations; 

 

P is the weight of the observations; 
 
n - f is that the total numbers of observations subtracts to the number of known number. 

 

RMS means the quality of the observations. The smaller the value of RMS is, the better the 

quality will be; The RMS is not effected by the observation time. 

 

According the theory of Symbolic Statistics Mathematical Statistics, the rate of the 

observation error within the 1.96 times RMS is 95%. 



 

 

 

 

 

 

Point Precision 

 

Point precision is an important standard of the internal accuracy of solution results. It is 

depended on line with the strength of the satellite geometry and RMS, it can be divided into 

the precision of horizontal direction, precision of the vertical direction, the baseline length 

precision and so on. The software will check the different accuracy standard according to 

tolerance setting of a project. 

 
 

5.3.2 Closed Loop and Repeat Baseline Testing 
 

Closed Loop 
 

1. The Definition of the Misclosure 
 
The closed loop test is an useful way to verify the quality of the baseline. The closed loop 

includes the synchronous loop, asynchronous loop and the duplicate baseline. In theory, the 

misclosure of the closed loop is zero, but in practice, surveying a certain deviation is 

allowed. Please refer to the relation information about the deviation limit. 
 
The types of the misclosure are as the followings: 

 
1.
 Component misclosure, that is:

 

 

 

 

 

 

 

 

 

 

2.
 Total misclosure, that is:

 

 
 
 

 

2. Synchronous closed loop 
 

 

 



 

 

 

 

 

 

The misclosure of the closed loop is the misclosure of the closed loop formed by the 

observation baselines. Because of the relativity among the baselines, the misclosure should 

be zero in theory. If the deviation of the misclosure is out of the limit, then one baseline 

vector is wrong at least. If the misclosure is within the limit, it generally means that most 

static baselines are OK. 
 
3. Asynchronous closed loop 
 
The asynchronous closed loop is a closed loop formed by all the baselines synchronously. 

The misclosure of the asynchronous loop is the asynchronous loop‟s misclosure. If the 

misclosure is within the limit of the deviation, it means the baseline vector is OK. If the 

misclosure is greater than the limit of the deviate, it means that at least one vector is not OK. 

You can check which baseline vector is not OK by the vicinity asynchronous loop and the 

duplicate baselines. 
 
Repeated Baselines 

 

The observation result between two stations at different observation times is the repeat 

baselines. The difference between the repeat baselines is the repeat baselines comparability 

difference. 
 

5.3.3 Identify Every Effect Factors 
 

Effect Factors 

 

Factors effecting on the baseline‟s result are as follows: 
 
 
 
 
 

 

 



 

 

 

 

 

 

 

 

1. The starting coordinate setting is wrong when you process the baseline. The wrong 

starting coordinate will cause the baseline deviation in the scale and direction. 
 
2. The too short observation time cannot decide the integer ambiguity of the satellite. And 

for the baseline processing, if the integer ambiguity corresponding is not computed, the 

baseline processing result will be effected. 
 
3. The number of the cycle slips is too big during some time and cause the cycle slips 

repairing is not perfect. 
 
4. The multi-path effect is very much during the data collection, and the corrections of the 

observation value are general big; 
 
5. The effect on the troposphere and ionosphere is too much; 
 
6. The electromagnetic noise cannot be ignored. 
 
7. The receiver itself has problem and cause the quality of the data too bad, e.g. the 

degraded phase accuracy of the receiver or the clock of the receiver is not accurate. 
 
Problems and the Solutions: 

 

1. The identification of the effect factors on the GPS baseline resolution 
 

 In the effect factors, some are easy to distinguish, such as the too short observation time, 

too many cycle slips, serious multi-path effect and too much effect from the troposphere or 

ionosphere. But other factors are not easy to tell, such as the inaccurate starting coordinate. 
 

 The inaccurate starting coordinate 
 
It‟s not easy to tell the effect of inaccurate starting coordinate to the quality of the baseline 

solution, so the beginning coordinate have to be as accurate as possible. 
 

 The identification of the short observation time 
 
You can tell this factor easily. You can view the number of each satellite‟s observations in 

the record files. The TGO Software Package supplies the visible satellite map. 
 

 The identification of many cycle slips 

 

You can analyze the observation residual of the baseline solution to tell the cycle slips. Now 

most baseline processing software use the dual-difference value, so when the observations 

include the uncorrected cycle slips, all the residual of the dual-difference corresponding to 

the cycle slips will have the obviously increase at several times. 

 



 

 

 

 

 

 

 

The Identification of the serious multi-path effect and the too much effect of the 

troposphere or the ionosphere refraction 
 
To the multi-path effect and the refraction of the troposphere or the ionosphere, we 

distinguish them by the residual of the baseline, too. But different to the integer cycle slips, 

when the multi-path effect and the refraction effect of the troposphere or the ionosphere 

serious, the residual increase within one time not several times and obviously bigger the 

normal residual. 
 
2. Solutions 
 

1）Inaccurate starting coordinate 
 
To solve the problem starting from the inaccurate points, you can use the most accurate 

point as the starting point when you process the baseline. The relative accurate starting 

coordinate can be got by the long time point positioning or connecting with the more 

accurate the WGS-84 coordinate, or do as the following way: 

 

When you resolve the baseline in a network, select one point‟s coordinate as the derivation 

of all the points‟ coordinate, so it is the baseline‟s starting coordination, then all the 

baselines have the same system error, so you can introduce the system parameter to resolve 

it during the network adjustment.  
 

2） Too short observation time 
 
If the observation time is too short, you can delete their observations. So you can improve 

the result by preventing them from solution. 
 

3）Too many cycle slips 
 
If in an observation time, many satellites have lots of cycle slips, you can remove this time 

to improve the solution quality. If only one or two satellites have too many cycle slips, you 

can delete the satellites to improve the solution quality. 

 

4）Serious effect of the multi-path 
 
The result of the multi-path effect is that the observation value residual is too big, so the big 

residual observation value can be deleted by reducing the edit dilution. Or you can delete 

the observation time or the satellite effected on serious by the multi-path. 

 

 

 

 

 

 

 

 

 

 
 



 

 

 

 

 

 

5）Serious effect of the troposphere or the ionosphere refraction: 
 
 Increase the elevation cutoff angle and delete the data of little elevation angle which is 

effected on by the refraction easily. But this method is not smart, because the signal of 

little elevation angle may not be effected severely.
 

 Modify the delay of the troposphere‟s or the ionosphere‟s model.
 

 If the observation value is dual-frequency, you can use the value, the fraction of the 

ionosphere is not used.



 

 

 

 

 

 

The Residual Map 

 

The residual map is a useful tool to condense the baseline processing. When you process a 

baseline, it‟s often necessary to solve the solution problem, for example, which satellites, or 

during which observation time, has problem. The residual map is useful to solve this 

problem. The baseline residual map is a figure expressing the residual of the observations. 

Select the Previous or the Next, you can view the residual of the combination of each 

dual-difference. See Figure 5- 8. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
This picture above is a general format of the baseline residual map. The horizontal axe is 

the observation time, the vertical axes are the observation residual. 

 

The residual value fluctuates with the zero axes, and the amplitude is within 0.1 cycle. 

 

5.4 Reprocess a Baseline 
 

If the reason for the baseline‟s quality is found, you can reprocess this baseline by changing 

the baseline processing setting or editing the observation time of the baseline. 
 
In the observation map, you can drag the mouse to select the deleted data. See Figure 5- 9 

Processing edit, the data in the broken lines box will be removed, and will not be processed. 

 

 

 

 

 

 

 

 

Figure 5- 8 Residual map 



 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When you find the processing is not qualified during the baseline surveying, you need to 

change the setting of the baseline or edit the observation time. If you still cannot get the 

qualified solution, you should prevent this baseline from being processed by the network 

adjustment or delete this baseline. If the baseline is mandatory in the control network, you 

should resurvey this baseline.  

 

5.5 Dynamic Route Processing 
 

The dynamic route post-processing is the post-difference data processing. The 

post-difference is different from the Real Time Kinematic, which can get the surveying 

result at once, while the post-difference cannot get the result until the inner processing is 

finished. If the post-difference processing cannot get the qualified result from the 

observations processing, the dynamic post processing will not be completed successfully.  
 
The operation of dynamic post-processing is easy, do it as dynamic route processing section 

of quick start guide chapter. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Figure 5- 9 Processing edit 



 

 

 

 

 

 

 
 
 
 

 

6. Network Adjustment 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 



 

 

 

 

 

 

After you process the baseline, you should test again the result of the processing, optimize 

the result, and transform the coordinate to the needed national coordinate or the local 

coordinate. All the above is the content of the network adjustment. The method of this 

software network adjustment is the Least Square method. 
 

6.1. Function and Steps of Network Adjustment 
 

TGO has the function of processing the free network adjustment, the 3D constrained 

adjustment, the 2D constrained adjustment and the height fitting. 
 
Please see Figure 6- 1 for the basic network adjustment steps for the TGO Software 

Package, the network adjustment includes three procedures. 

 
 

 The preparations done by the user. You need to set up the coordinate, enter the latitude 

and longitude, the coordinate, the elevation of the known points;
 

 

 Process the network adjustment, which is done by the software;
 

 The analysis and control to the quality of the processing result, which are done by the 

user. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 6-1 

 

We can find that, the software only achieves the solution of the network adjustment. What 

is more important is the involvement of the user to get a right result, and this is often an 

iterative procedure. 
 

6.2. Network Adjustment Preparation 
 

Coordinate Setting 

 

You should check the setting of the coordinate before set up the network adjustment. The 

details of setting coordinate system, please reference to Set the Coordinate Parameters 

in section 4.1. 

 
 
 
 
 
 
 
 
 

 

 

Figure 6- 1Network adjustment steps 



 

 

 

 

 

 

 

 

Network Adjustment Setting 

Select Adjust /Adjust options menu or click in the navigation field, the dialog in 

Figure 6- 2 will display, you can set adjustment parameters and test parameters. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

Control-point Coordinates 

 

After network adjustment setting is completed, you need to enter control-point coordinate, 

or you cannot do constrained adjustment. There are several methods to enter the 

control-point coordinate: 
 
1. Click Set as Control Point in the pop-up menu of sites list to set the site to control point. 

Figure 6- 2 Adjust options 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

2. Click Set as Control Point in the pop-up menu of control point list to enter the control 

point info. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

3. Click Import Control Point File in the pop-up menu of control point list to import the 

existing control point file to the project. 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 6- 3 Control points setting 1 

Figure 6- 4Control points setting 2 



 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

After entering control point info, you can click Save to Control Point File in the pop-up 

menu of control point list to save control point file. 
 

6.3. Run Network Adjustment 

Run Adjust in the Adjust menu, or click  button in the navigation field. Generally, just 

choose auto adjust mode, TGO will process network adjustment based on the known 

baseline processing result, the network adjustment setting, the observation point‟s 

coordinate. When adjustment is completed, the software will form the adjustment results 

list, select an adjustment result, then click Get Report button, you can view the 

corresponding adjustment report. 

 
 
 
 
 
 
 
 
 
 

 

Figure 6- 5 Control points setting 3 



 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Get Baseline Vector Network 

 

The first step to run the network adjustment is to get the baseline vector network. The 

principles to form the vector are listed below: 
 

1．This baseline is in this project and it is not be deleted; 

 

2．This baseline has a starting name and a calculation name; 

 

3．This baseline is computed and display as a qualified baseline in the vector list ; 

 

4．This baseline is not set up to not attending the solution and the network adjustment. 
 
The baseline meeting the items above will be downloaded in the first step of the network 

adjustment and form a baseline vector network.

Figure 6- 6 Network Adjust page 



 

 

 

 

 

 

Check Connectivity of Baseline Vector Network 

 

If you process the adjustment with the network not connective, the result of the adjustment 

cannot converge. TGO will test the connectivity of the network automatically before the 

adjustment. If the network is not connective, you will find the error message as Figure 6- 7: 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

So you should test the baseline vector, the observation point name of the baseline vector 

network. The steps are listed below: 
 
1. Check the map whether it is divided into several parts, or it has the separated 

observation sites or baselines, if yes, delete the separate point or process baseline 

respectively. 

 

2. Make sure the key baseline is computed successfully, and it is not prevented from the 

network adjustment. You should reprocess or resurvey the key baseline if it is in the above 

situation. 

 

3. Make sure no observation site with two difference names, which will be shown on the 

map two points with little distance. Because the two points observation is the observation 

of the same site at different time, so they cannot form a baseline and the map is not 

connective. The solution is to modify the error station name in the observations property. 
 

 

 

Figure 6- 7 Network error message 



 

 

 

 

 

 

 
 
Adjustment Report 

 

The results of the adjustment will be reflected in the report. Adjustment report content and 

display format can be set in the Adjust Report Options window (Figure 6- 8). A network 

adjustment example is given in Figure 6- 9. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6- 8 Adjust report options 



 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

Test Network Adjustment Result 

 

The result of the network adjustment should be checked after the adjustment. To evaluate 

the quality of the network adjustment, the corrections, the mean square error and the 

corresponding data statistics result should be checked. 
 
The net adjustment of mathematical statistics test includes the X2 test and Tau test. 
 
 X2 test shows the reliability of the results of adjustment. If the X2 test value is less 

than the theoretical value, it indicates that adjustment result of the error is smaller than 

the theoretical error. That is, the adjustment results are good enough, and generally no 

need to deal with or select the appropriate "baseline standard deviation confidence 

level (relaxation factor) to make the X2 test. If the X2 test value is greater than the 

theoretical value, the error of the adjustment results exceed the range which can be 

accepted, it means the baseline solution error is too large or the control point 

information has gross errors, you should find the problem with baseline or control 

points, and process again until test passed. 
 
 Tau test is used to test the existence of gross errors in the baselines involving 

adjustment. Generally, the test result depends on every baseline corrections. If a 

baseline Tau test cannot be passed, you need to process baseline again and then make it 

participate in the adjustment, or disable the baseline directly. 
 
 

 

 

 

 

 

Figure 6- 9 An adjust example 



 

 

 

 

 

 

If the result of the network is disqualified, the following items are for your reference: 

 
 
1. Make sure the coordinate setting is right; 

 

2. Make sure the known point is correct and in the same system; 

 

3. Make sure the baseline vector map is correct. If there is a disqualified static baseline, 

you can prevent it from network adjustment. If this baseline cannot be deleted or is very 

important in the baseline network, you need to compute this baseline again or survey 

again if it‟s needed; 

 

4. Make sure the observation site and antenna height is correct for the observation files. If 

it is wrong, the misclosure or the result of the free network adjustment will be very bad. 



 

 

 

 

 

 

 

 

 
 
 
 
 

 

7. Report 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 



 

 

 

 

 

 

 

 

In this chapter, we will introduce the detail context of various reports. 
 

7.1 Static Baseline Processing Report 
 

The static processing report consists of reference, rover, processing controls, tracking, 

baseline solution, ambiguities. 
 
 
 
 
 
 
 
 
 

 

 

 

Reference and Rover Info 

 

It records the reference point/rover info, such as name, code, the spatial rectangular 

coordinate under WGS84 coordinate system, geodetic coordinate under WGS84 coordinate 

system, receiver info and Antenna info. 

 
 
 

WGS84 spatial 

rectangular coordinate 
 

 

 
WGS84 geodetic 
coordinate 

 
Receiver Info 

 
 
 

Antenna Info 
 
 
 
 
 
 

 

 

 

 

 

 

Figure 7- 1 Static report 

Figure 7- 2 Reference information 



 

 

 

 

 

 

Processing Control 

 

This part mainly record the observation start time of baseline and end time some processing 

control parameters which you set in the procession options window. 
 
Ambiguities 

 

This part records the status of integer ambiguities solution, such as the following figure: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

7.2 Network Adjustment Report 
 

This report is generated by network adjusting. Here we just introduce one report with 

adjustment-free method. 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Figure 7- 3 Ambiguities report 

Figure 7- 4 Network Adjustment report 



 

 

 

 

 

 

 

 

The header of report is the result of adjustment test. You can know the adjustment result by 

these values. For example the test result in Figure 7- 5, the X2 Test result is not in the 

accepted range, it is not passed. You need to check the baseline according to above chapter. 

 
 
 
 
 
 
 

 

 

 

If the result of the network is under qualified, the baseline of problematic vector will be 

highlighted in red as Figure 7- 6. You need to check the baseline according to above 

chapter. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 

Figure 7- 5 Report header 

Figure 7- 6 Adjusted baseline report 



 

 

 

 

 

 

 

 

7.3 Dynamic Route Processing Report 
 

There are three types of reports: RTD report, Stop&Go report and PPK report. RTD report 

includes three parts: Reference point info, Coordinate system parameters and every point 

info of the rover. And the stop&go report and PPK report has stop point info besides RTD 

report context. 



 

 

 

 

 

 

 

 

 
 
 
 

 

8. Import and Export 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

 

 

 

 

 

 

 

In this chapter, we will introduce the import and export function of the software. 
 
The TGO Software Package can support many kinds of function about import and export. 

Generally, the output part will be hand in, as a part of the result, when you hand in the result 

text. 
 

8.1 Import and Export Observations and 
Ephemeris 

 

For imported observations, we can convert them to RENIX file by choosing Convert to 

RINEX item in the pop-up menu (Figure 8- 1). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8- 1 Convert to Rinex format 



 

 

 

 

 

 

 

 

You can select  in the navigation to batch conversion (Figure 8- 2). The export 

achievements are in the "Rinex" folder under project folder. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

8.2 Export the Coordinates of Result Points 
 

In Figure 8- 2, if Points Files item to export is selected, you can get the coordinate of result 

point of TXT format. 
 
The coordinate of point is separated by „,‟ symbol: 
 

Point name, Latitude, Longitude, Ellipsoidal Height, Northing, Easting, Normal 

Height 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Figure 8- 2 Batch convert 



 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

8.3 Export Network Map 
 

TGO software package can export Network Map with DXF format. Select Project Plot 

DXF item to export Network Map. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Notice: If graphics can‟t be shown in CAD software, it‟s in out of 

the zoom range. Please type the command e, z in the CAD 

software, it will automatically zoom to graphics view area 
 
 
 

 

 

Figure 8- 3 Export points 

Figure 8- 4 Network map export 



 

 

 

 

 

 

 

 

8.4 Export Baseline Result 
 

TGO software package can export baseline result as Figure 8- 5. After exporting, click 

Folder button, you can view the corresponding format baseline result. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

8.5 Export Report 
 

TGO software package can export project report with format:  
TXT, DOC, HTML 
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Figure 8- 5 Export baseline 

Figure 8- 6 Report format 

http://dict.youdao.com/search?q=corresponding&keyfrom=E2Ctranslation


 

 

 

 

 

 

 

 

 

 
 
 
 

 

9. Using of Tools Software 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 



 

 

 

 

 

 

 

 

The Common tools software of the TGO Data Processing Software Package includes the 

antenna manager, the satellite prediction software, the Coordinate transformation tool, and 

the Precise ephemeris download tool. This chapter mainly introduces the methods and the 

answer to some common questions.  
 

9.1 Usage of Antenna Manager 
 

Antenna manager is designed for updating and editing the receiver parameter file (The 

"HitAnt.Ini" file). When you used the unknown receiver type but know the geometric 

parameter of the receiver and the phase center height parameters, you can use this tool to 

add the receiver you needed. 
 
Select Tools-> Receivers in the menu, there will be pop-up window, in the Antenna, you 

can set up some commonly used parameters here, such as the radius, the phase center height. 

See Figure 9-1: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

In the list window, select the name of the antenna, you can change the corresponding 

parameters directly. 

 

Notice: This file would influence the data achievement, please 

don‟t change it easily! 
 
 
 

9.2 Coordinate Transformation Tool 
 

The TGO Data Processing Software Package supplies the coordinate transformation tool. 

Choose Coord Tool in the Tools menu to function the coordinate transformation tool. 

Figure 9- 1 Receiver antenna information 



 

 

 

 

 

 

This software can transform between the local coordinate and the WGS84 coordinate, 

meanwhile it can calculate the parameter. The following is about these tools in details: 
 

9.3 Summarize 
 

Firstly, you should know the representation of each coordinate. The common methods are 

the Longitude-Latitude and Ellipsoid Height (BLH), the Space Rectangular Coordinate 

(XYZ), the Plane Rectangular Coordinate and the Geoidal Height (xyh/NEU). The 

ellipsoid height is a geometric sense and the geoidal height is a physical quantity. 
 
The WGS84 is of the BLH system, the Beijing 54 is of the Plane Rectangular Coordinate. 
 
Now it comes to the accuracy of the transformation. In an ellipsoid, the transformation is 

rigor (BLH--XYZ), but the transformation in different ellipsoid is not rigor. e.g. There is no 

a transformation parameters can be used all over the national between the WGS84 

coordinate and the Beijing 54 coordinate, because the WGS84 coordinate is a geocentric 

coordinate system, but the Beijing 54 coordinate is a local geodetic reference system. The 

elevation‟s transformation is between geoidal height and physical quantity. So in each place 

must use local ellipsoid fitting, usually with seven parameter model to fitting. 
 
Generally, the more rigor method to transform coordinate between different ellipsoid is the 

seven parameters transformation. That is the X plane, the Y plane, The Z plane, the X Spin, 

the Y spin, the Z spin and the Scale Dilution K. For getting the seven parameters in a 

location, you should have more than three points. If the area is not large, the furthest point is 

within 30km, and you can use the three parameters, that is X plane, the Y plane, and the Z 

plane. The X spin, the Y spin, the Z spin and the Scale Dilution K are regards to be zero. 

The tree parameters are the special of the seven parameters.



 

 

 

 

 

 

 
 
The essence of the seven parameter model with a local ellipsoid is to fit the 

form of local coordinate system; so the local ellipsoid height after 

transformation is the geoidal height. Of course, we can also fit it in the 

different direction of plane and elevation. For example, using the four 

parameter model to fit in the plane, and using the secondary surface model to 

fit in the elevation direction. This mode of handled separately is more 

freedom than seven parameter model. But because the four parameters 

model has less parameter, a weak ability of expression, usually uses for 

small regional coordinate transformation. 
 
To sum up, the TGO coordinate transformation tool provides two practical 

transformation strategies to choosing by the customers: 
 
1. Seven parameter model, one step to get local plane and level data. 
 
2. Four parameters and elevation fitting model, which is divided into two 

steps to get local plane and level data. 
 
Because each company has a different definition of the model and process, 

here is our company's conversion process, its description as follows: 

 

The conversion process of seven parameters model is in below: 
 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 The conversion process of four parameters model is like this:
 

Figure 9- 2 Conversion process of seven parameters model 
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The conversion process of elevation fitting is in below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9- 3 Conversion process of four parameters model 

Figure 9- 4 Conversion process of elevation fitting 



 

 

 

 

 

 

Use Software to Transform Coordinate 

 

This software manages the coordinate transformation parameters with file (*.dam), you can 

save a group of transformation parameters in a file, and next time you can open this file to 

transfer the parameters in the file menu. 
 
The coordinate transformation parameters are generally include the ellipsoid parameter, 

projection parameters, seven parameters, four parameters, elevation fitting parameters, level 

grid files. All these parameters‟ input integrated to the following page. After input the 

parameters, input a file name, and click Save button, will create a “*.dam” parameter file in 

the “GeoPath” directory which in the “Program” folder. 
 
Click the Parameter menu: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9-5 
 

 

 

Figure 9- 5 Parameters 



 

 

 

 

 

 
 
In this page, complete inputting parameters, or click [V] drop-down button to select a file of 

coordinate transformation, then click the Ok button, will get back to the main window to 

positive and inverse transform coordinate: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Parameter Calculation 

 

When users have a group of control points (these points have both WGS84 coordinate and 

local coordinate), you can use this software to calculate the parameters. As previously 

mentioned, this software provides seven parameters model and four parameters and 

elevation fitting model solution, the calculation of two models is completed in the same 

interface, it‟s convenient to users to compare and choose different precision model. In the 

main interface, click the Parameter Clac in the Tools menu, can open the parameter 

calculation interface (if you have not input the ellipsoid and projection parameters, you will 

be prompted by pop-up the “Parameter” window). 

 

 

 

 

Figure 9- 6 Transformer window 



 

 

 

 

 

 

 
 
The process of parameter calculation is: 
 
1. Input basic parameters: First, input local ellipsoid and projection parameters. 
 
2. Import data: Add points coordinate one by one or to one data, or prepared the text file 

first then click the Open button (prepare note: file format is [Name, B, L, H, x, y, H]). 
 
3. Calculate parameters: The software support two modes of coordinate transformation, 

click the Calc Bursha Parameter or Calc Helmert 2D + Height, if use the second mode, 

please selected the model of elevation fitting firstly. 
 
4. Check the result: In the result bar will show the calculated parameters, the user can 

copy and save them. 
 
5. Use parameters: Click the Parameter settings button to check the transformation 

parameters, the ellipsoid parameters and the projection parameters. Make sure these are 

correct, then you can input a name and save as a “*.dam" file, this file also can be used in 

other Tersus software. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 

Notice：Please switch to the Map view and check the geometric 

distribution of the points used to calculation (Avoiding the 

points are presented a linear distribution, lead to the parameters 

has poor applicability and stability. 
 
 

 

9.4 Satellite Prediction Software 
 

The TGO Data Processing Software Package supplies the Satellite Prediction software. 

Choose Star Report in the Tools menu to inactive the Satellite Prediction software. 

 

Figure 9- 7 Parameter calculation 



 

 

 

 

 

 

 

Satellite prediction is used to forecast the distribution conditions of satellites at a certain 

time in a certain area according to the satellite almanacs data collected by receivers. The 

field engineer can choose proper time to do fieldwork, which will make the fieldwork more 

effective and the data better. 
 
The general steps of this software are given below: 
 
1. Update historical data; 
 
2. Set stations‟ position and time, elevation angle; 
 
3. Forecast, check the number of satellites, check the sequence chart of DOP value, and 

choose the measuring time. 

 
 

 

Input Almanacs Data (Yuma format) 

 

Yuma is a kind of almanacs data format broadcast on internet by America. GPS users all 

over the world can download the latest almanacs data on the specific official website: 
 

http://www.navcen.uscg.gov/ftp/GPS/almanacs/yuma/ 
 
Select Download Yuma (GPS) in the Help menu, the software will download the latest 

Yuma files, save it automatically and show you “download finished”. See Figure 9- 8: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Observation Station Coordinate and Observing Period Setting 

 

After the latest almanacs data is loaded, you need to set up the station BL, height, height 

cutoff angle, observation period and so on, which will enable the software to calculate the 

parameters. 
 
You can set up the date in Status window. The default value is the date of computer system. 

Users can choose any day by  
“reviou”, “Today”, “Next”, “Manual”. See Figure 9- 9: 
 
 
 
 
 
 
 
 
 
 
 

Figure 9- 8 Star report 



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

Click Setup ->Option… to set up the station BL, height, elevation cutoff angle, observation 

period. See Figure 9- 10: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Figure 9- 9 Status window 

Figure 9- 10 Setup options 



 

 

 

 

 

 
 
The BL coordinate can be coarse, 1~2 km precision will be ok. Users who does not know 

the BL coordinate can get it as follows: 
 

 With the coordinate transformation software, users can transform the XYZ of a known 
point to BLH and then input them into the software to do satellite prediction.

 

 

 Get the BLH format coordinate by specific GPS instruments as HD8100, HD8088, or 
HD8800, input the BLH into the software to do satellite prediction.

 

 
Please pay attention to the selection of the local time and GPS time when you set up the 

observation period. And ensure the difference between local time and UTC time when you 

input the observation period in local time setting. Usually the computer will suggest you to 

choose time zone while installing.  

 

When entering the observation period, please make sure that the difference between the 

start time and the end time is several hours to 24 hours, and the start time is always ahead of 

the end time. See Figure 9- 11: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The angle will limit the azimuths of the prediction satellites in the way that only the 

satellites whose azimuths are over the threshold can do the prediction. Sampling rate 

control the data output interval. The smaller the sampling rate, the more detailed the data 

are. See Figure 9- 12: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 

 

Figure 9- 11 Time config 

Figure 9- 12 Instrument set 



 

 

 

 

 

 

Satellite Status Prediction 

 

After the observation station coordinate and the observing period are input, click ok button, 

you can check the satellite status in any view window. 
 

1. Export satellite detailed status, Click  button See Figure 9- 13:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

2. Satellite tracking map 
 
Satellite tracking map shows the change of the number of the visible satellites with the time 

elapsing in the limited period. With the map, users can choose the period when the visible 

satellites are more to do observation so as to improve the fieldwork. Click  button. See 

Figure 9- 14: 

 

Figure 9- 13 Detailed satellites’ status 



 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

3. Constellations map 
 
Constellations map shows the distribution conditions and the movement of satellites at a 

certain time in a certain area. For example, in the Figure (click ), the satellite 32 will 

travel northwest to south in prediction. And the map shows the BL coordinate as well as the 

observing period. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

Figure 9- 14 Satellites tracking map 

Figure 9- 15 Constellations map 



 

 

 

 

 

 

 
 
4. Number of the visible satellites and the PDOP 
 

Click  the relationship of the satellites number and the time will show in upside map 

while the PDOP will show in the downside map. The PDOP denotes how the positioning 

accuracy acts on satellites distribution. See Figure 9- 16: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

5. World map Click , you can see the satellites traveling tracks in the world map. See 

Figure 9- 17: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9- 16 PDOP value 



 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

6. Print out 
 
File shows, satellite number, PDOP value and satellites distribution all can be print out. 
 
 

 

Update Ephemeris Data 

 

To predict satellites precisely, the ephemeris data should be updated often. It‟s 

recommended that ephemeris should be updated once in a month. The config of the 

software can prompt users to update the ephemeris when it‟s necessary. 

 
 
 

Precise Ephemeris Download Tool 

 

In order to improve the precision of the static data processing software, you can download 

SP3 precision ephemeris data from the FTP server which is provided by the United States 

IGS. This tool is developed for automatic download the data rapidly and easily from the 

data server. It‟s easy to use, just select the data date and data types, click Start to download. 

Figure 9- 17 Satellites world map 



 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Notice ：In the whole world, there are multiple FTP servers providing data 

download service. Please choose a proper download site to 

download the data according to your field site. 
 
 
 
 
 
 
 

Figure 9- 18 Download SP3 file 


